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Summary 

Objectives 

The objective of this document is to describe the aim of EDGE, how to use it and the main 

concepts behind it. 
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1. Introduction 

1.1. Scope of the document 

This document describes the EDGE CAD editor, the context and the concepts behind its 

conception, as well as its use.   

1.2. Reference documents 

[RD1] GDML Web page, http://gdml.web.cern.ch/GDML/ 

[RD2] Geant4 Web page, https://geant4.web.cern.ch/geant4/ 

[RD3] SpaceSuite Web site, www.space-suite.com 

[RD4] Santin G. et al., “GRAS: A General-Purpose 3-D Modular Simulation Tool for Space Environ-

ment Effects Analysis”, IEEE Trans. Nucl. Sci., Vol. 52, No. 6, December 2005 

[RD5] Jeanty-Ruard B. et al, “Advanced CAD Tool and experimental integration of GRAS/Geant4 for 

internal charging analysis in SPIS”, Proceedings, 14th Spacecraft Charging Technology Conference, 

ESA/ESTEC, Noordwijk, NL, 04-08 APRIL 2016 

[RD6] Keridwen open-source IME Web site, www.keridwen.org 

[RD7] SPINE community Web site, www.spis.org 

[RD8] EDGE project Web page, http://dev.artenum.com/projects/edge_extended_gdml_editor 

[RD9] GDML USER’S GUIDE; Version 2.7; http://gdml.web.cern.ch/GDML/doc/GDMLmanual.pdf 

1.3.  Acronyms and abbreviations 

 B-Rep: Boundary Representation 

 CAD: Computer Assisted Design 

 CSG: Constructive Solid Geometry 

 EDGE: ExtendeD Gdml Editor 

 GDML: Geometry Description Mark-up Language 

 GUI: Graphical User Interface 

 IME: Integrated Modelling Environment 

 STL: STereo-Lithography 

 UNV: Universal File Format 

 XML: Extensive Markup Language 

http://gdml.web.cern.ch/GDML/
https://geant4.web.cern.ch/geant4/
http://www.spis-services.eu/
http://www.keridwen.org/
http://www.spis.org/
http://dev.artenum.com/projects/edge_extended_gdml_editor
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2. EDGE objectives 

EDGE — for ExtendeD Gdml Editor — is an easy-to-use GDML-based CAD editor. 

It provides a powerful and flexible CSG model fully compliant with the GDML CAD format 

[RD1], used by numerous particle-matter interactions analysis tools based on the Geant4 

library [RD2]. EDGE provides also various import/export capabilities from/to B-Rep based 

CAD formats.  

EDGE has been developed by Artenum in the frame of its internal R&D activities and is 

available through several of its commercial services offers, like SpaceSuite [RD3].  

2.1. About GDML 

Based on XML syntax, the Geometry Description Markup Language (GDML) is the reference 

language used to describe geometrical models (i.e. CAD models) for radiation modelling 

tools like Geant4 [RD2], ESA/GRAS [RD4] or SPIS-IC [RD5]. GDML is based on a rich CSG 

approach and can be used to create complex and realistic geometrical systems to be used 

for various purposes. 

As an XML-based language, it can be fairly well read by humans and it is quite simple to 

parse it. However, one of its limits is that it is difficult to visualise what a GDML file is going to 

produce just by looking at it in a tailored sense, i.e. as a 3D geometrical system. Although 

some viewers or editors exist, only a few of them are publicly available, and they are not us-

er-friendly or incomplete. Moreover, most GDML editors so far cannot handle the depth hier-

archy used in GDML. 

Therefore, Artenum decided to develop a GDML editor based on the IME Keridwen [RD6]. Its 

aim is to propose a simple-to-use, cross-platform editor with good capacities of visualization.  

2.2. Main functionalities 

EDGE can either create or load a complete GDML model. In both cases, the user can modify 

the properties of all the shapes or add new shapes. Moreover, shapes also have position and 

orientation properties that allow placing them correctly. To facilitate the work for the user, 

position and orientation can be applied to several objects at the same time. EDGE handles 

complex hierarchies with several levels of depth.  

EDGE also allows editing and attributing material properties to each shape individually. At 

any time, the user can see the results of his work thanks to the real-time 3D. 

After editing his file, the user can save the result back to GDML but he can also export it to 

the B-Rep .geo format (the file format of Gmsh)1.  

                                                
1
 http://geuz.org/gmsh/ 

https://geant4.web.cern.ch/geant4/
http://space-env.esa.int/index.php/geant4-radiation-analysis-for-space.html
http://geuz.org/gmsh/
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2.3. Supported formats 

2.3.1. Import 

EDGE support natively the GDML format in reading and writing, but is also able to import 

numerous B-Rep CAD formats like Gmsh’s geo or STEP-AP 203/214 and tessellated solids 

in STL or UNV files. These import/export capabilities open interoperability bridges with other 

CAD tools and multi-physics simulation software. 

  

Figure 1: Example of imported STEP-AP model inside EDGE 
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2.3.2. Export and CSG-to-B-Rep decomposition 

EDGE is able to convert GDML models into an equivalent Gmsh’s geo file, fully compliant 

with tailored applications like SPIS [RD7]. This conversion is not done by tessellation but by 

a proper CSG to B-Rep decomposition with the view in Gmsh (on the top of Figure 2) of a 

model initially defined in EDGE (on the bottom of Figure 2). 

   

Figure 2: CSG to B-Rep decomposition of a GDML model defined in EDGE (left)  

visualized in Gmsh (right) 
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3. Using EDGE 

3.1. Supported platforms  

Currently, EDGE can be used on most 64bits Linux platforms, Microsoft Windows-7-8-10 

32/64bits and OSX/macOS 64bits.  

3.2. Starting Edge 

The application as well as the present User Manual can be downloaded from the SpaceSuite 

Web page [RD8].   

Once downloaded, the zip file containing the EDGE snapshot has to be extracted on the ma-

chine where it will be used on to ensure that the software is executable.  

NB: on Windows systems, the native unzipping method may encounter issues when unzipping EDGE. 

You may want to use third-party application to avoid issues. The unzip has been successfully tested 

with the 7Zip application. 

i. Linux  

Depending on your precise Linux distribution, double-clicking on the Edge.sh file may launch 

the application correctly (see below for more details on Gnome environments).   

To start the application, it is also possible to open a terminal and just execute ./Edge.sh in 

the application directory. It is then possible to indicate launching options, see the Command-

line launching options paragraph below. 

NB: on recent Linux distributions with Gnome, double-clicking on the Edge.sh displays the content of 

the file instead of launching it. You can modify this behaviour by going to the file manager preferences 

and changing the way executable files are handled. 

ii. MacOS 

To start the application, you need to open a terminal and execute the Edge.sh file. It is pos-

sible to indicate launching options, see the Command-line launching options paragraph be-

low. 

iii. Windows 

Double-clinking on the Edge.bat will launch the application. To use more advanced launch-

ing options, you can open a command invite and type Edge.bat. Options can be provided, 

see the Command-line launching options paragraph below  

http://www.space-suite.com/edge
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iv. Command-line launching options 

It is possible to use options to launch EDGE. The options can be added (one at a time) after 

the launching command. To know all the available options, the option –h can be used (such 

as ./Edge.sh -h or Edge.bat -h).  

-f path/to/gdml/file.gdml 

This option enables loading the given file at the same time than the application. 

3.3. EDGE Main Window 

The GUI of EDGE is intuitive and based on the concept of “perspectives”, where the mod-

elled system can be viewed and handled from different approach or points of view, like the 

edition of the geometrical model, the definition of material properties or the assignment of 

these materials to their correct geometric shape. 

As shows the Figure 3, some elements of the graphical interface are common for all perspec-

tives:  

  Main Menu corresponds to main control menu of the application.  

  General Toolbar presents shortcut buttons to open and save (on the left) a file 

and also allows switching from a perspective to another (on the right). This toolbar al-

so grants access to the preferences panel.  

 … 
  

Figure 3: Main elements of EDGE window (here in the geometry perspective) 

3.3.1. Main Menu 

i. File menu 

The File menu (shown on the right) allows opening and saving 

GDML files and also various import and export options. An option 

also permits opening recent files. Finally the exit option enables 

leaving the application. 

Please note that EDGE can only load one file at a time. When 

opening a GDML file, if there are unsaved modifications, the ap-

plication will propose to save this work before replacing it by the 

new opened file. 

2 

1 

  

 1 

2 



 EDGE 2.3.2 

User Manual 
PAGE 

11/37 

 

Status: final Date: 15/10/2018  

 

NB: EDGE tries to load all files, even if there are inconsistencies. For example, if a file contains two 

solids with the same name, EDGE will only consider the last element with this name and inform about 

this issue and the chosen resolution.  

ii. Tools menu 

The Tools menu (shown on the right) offers various tools and 

shortcuts. From here, you can access the preferences panel 

presented in section 4. The console log is displaying various 

messages from the application such as errors and warnings. 

This menu also offers access to various tools and model 

computation operations which are described in more details 

in section 5.5. 

iii. Other menus 

The Views menu allows switching from one of the perspectives presented earlier to another. 

The Help menu is useful to access this user manual directly from within the application. This 

menu also offers the about screen, resuming information about the software.  

3.3.2. General Toolbar 

The left part of this toolbar allows the user, thanks to three buttons, to access the Prefer-

ences, presented in section 4, and to easily open and save a file without opening the File 

menu presented in 3.3.1. 

The right part of this toolbar presents three buttons allowing the user to switch between the 

three main perspectives of EDGE: the Geometry edition (visible on Figure 8, see section 5), 

the Material definition (see section 6) and the Material affectation one (see section 7 for more 

information). 
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4. Preferences 

The Preferences dialog box allows the setting of the applications options. For each option, a 

“Reset to default” button allows switching back to the initial value. 

At the first launch of the application, the Preferences dialog box is shown and enables the 

user to change the default parameters right away. 

4.1. GDML default material preferences 

 

Figure 4: GDML default materials preferences 

The first tab — shown on Figure 4 — offers options concerning the default GDML materials 

used in the application. Indeed, when a new shape is created in EDGE, a default material is 

assigned to it that can be changed later on in the Material Assignment perspective (see sec-

tion 7 page 34).  Here, it is possible to select which material will be assigned to the world 

element and to other elements. The selection can be performed from within the EDGE de-

fault materials list and the Geant4 default materials list. 
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4.2. GDML writer preferences 

 

Figure 5: GDML writer preferences 

The second tab, shown on Figure 5, sets parameters for the GDML writer: 

 Write default values: if this option is selected, the values for optional fields will be 

written even if they equal to the default value — it is the case for example for the posi-

tion and orientation (0 is the default value); 

 Write default units: if this option is selected, the units will always be specified inside 

the GDML file even if they equal to the GDML default units (mm for lengths and radi-

ans for angles); 

 Write non-used user-defined materials: if this option is selected and that the user 

has defined materials which are not assigned to a geometric shape, those materials 

will be stored in the GDML file anyway; 

 Save chosen colours to GDML file: if this option is selected, the colours chosen in 

the Geometry panel will be saved to the GDML file using the <auxiliary> tag, and 

then when loading the file the colours will be the same. Be careful, the content of the 

<auxiliary> tag is not interpreted by the Geant4 numerical kernel. This tag is usually 

properly treated by the client code as explained in the GDML user manual [RD9] 

 Validation mechanism in GDML file: Choose the reference to the GDML file valida-

tor (.xsd) defined in the GDML file after the save action in EDGE. The choices are: 

o online (the validation process requires an internet connection when the file in 

other tools is loaded); 

o local (the validation is made locally with a validator file embedded on the local 

computer. The saved GDML file can only be used on this computer as long as 

the software is not moved); 

o none (no reference to a GDML file validator is written, then no validation will be 

processed when the GDML file will be used by other tools). 
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4.3. General preferences 

 

Figure 6: General preferences 

The third tab offers more general usability preferences, as shown on Figure 6: 

 Default 3D view shape opacity: sets the default opacity used when adding a new 

shape to the 3D view. Indeed, a colour is automatically chosen for every new shape 

and this setting will choose the opacity for this colour. The value 0.0 is fully transpar-

ent while the value 1.0 is fully opaque. Please note that this setting will not change 

the opacity of the shapes already displayed in the 3D view; 

 Maximum number of recent files: this option controls the number of recent files 

stored by EDGE and accessible in the Open recent… menu.  

 Enable drag’n’drop: enables the possibility to move the elements in the Shapes tree 

using drag and drop gesture with the mouse. It facilitates the modification of the hier-

archy — to avoid unwanted modifications, this option is disabled by default;  

 Display “Add new shape” labels: display shortcut labels in the shapes tree of the 

Geometry Edition perspective. These labels help to gain time to add new shape but 

this option is disabled by default to gain cleanliness. 
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4.4. GDML default material preferences 

  

Figure 7: System options 

The last tab sets preferences for the system, as shown on Figure 7. The user can choose: 

 Application cache directory: by clicking on the “Browse” button, the user can 

choose the path where the application stores its temporary files. It may be useful to 

change this setting if you do not have write access to your temporary folder (by de-

fault EDGE uses the operating system default temporary folder); 

 Maximum allocated memory: the user can choose the value and unit (Mo or Go) of 

the available memory for EDGE. It can be useful to increase this value when loading 

very big files, without exceeding the system maximum capabilities. 

NB: As mentioned in section 3.2. iii, this option will not be taken into account when launching 

EDGE with the EDGE.exe on Windows systems. 
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5. Geometry Edition 

The Geometry perspective is the main perspective of EDGE since it allows the creation and 

the edition of geometrical elements. 

5.1. The Geometry edition perspective 

It is the main perspective of EDGE displayed by default at the launching. It has three main 

panels to edit the geometry, as shows Figure 8: 

  Shapes Tree panel, to visualise and edit the list of geometric shapes; 

  Properties panel, to edit the properties of the currently selected shape; 

  3D Viewer panel, present only for the geometrical edition and material affectation 

perspectives, provides a 3D view of the modelled system.  

These panels, as well as the 3D View panel, can be moved, detached or maximized at the 

user’s liking using the buttons on their top right corner. 

 

Figure 8: EDGE geometry edition view 

  

3 

2 

1 

 

  
1 

2 
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5.1.1. Shapes tree 

The Shapes tree lists all the shapes currently defined in the geometrical model and displayed 

in the 3D scene. It also shows the hierarchy of the shapes. The shape(s) currently selected is 

(are) highlighted in the 3D view on the right with a red box. It is also possible to move one 

geometry element and all its children elements to another logical location in the geometry 

tree. This feature is available only if the drag’n’drop option has been enabled in the Prefer-

ences, see section 4. 

On the right of each shape, a click on the coloured box opens a dialog that allows changing 

the colour of the shape in the 3D view. It is also possible to change the transparency of the 

selected element in this dialog box, as shown on Figure 9. A checkbox on the right controls 

the visibility of the object in the 3D view.  

 

Figure 9: Colour changing dialog box 

On top of the tree, five buttons are used to control the shapes:  

 The three buttons on the left side allow adding, duplicating and/or removing shapes. 

The first one ( ) opens a dialog box to add a new shape to the tree (more details 

in section 5.4.1). The second one ( ) duplicates the selected shape(s) and the 

third one ( ) deletes all the shapes currently selected in the tree.  

 The two buttons on the right side allow performing actions on the currently selected 

shape(s). The first one ( ) opens a dialog box to apply a transformation to all the 

elements currently selected (see section 5.4). The second one ( ) offers the pos-

sibility to use a clipping filter. This button triggers the apparition of a dialog box allow-

ing the user to set the parameters of the clipping filter, see Figure 10. This filter per-

forms a cut in the geometry to view more precisely the inner geometry of the mod-
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elled system. The clipping is set with the coordinates of a centre point and a normal 

direction. It will keep the geometric representation of the selected element in the half-

space defined by this point and the normal. To get a more interactive setting, you can 

select the “Display 3D control widget” that will display an interactive control in the 3D 

view to change the clipping. These 3D controls of the filter are materialised by a 

sphere (representing the centre of the clipping operation) and an axis with two arrows 

(representing the normal direction), see Figure 10. 

 

    

Figure 10: Clipping filter applied on Raspberry Pi Zero housing with the 3D control 

widget enabled (left) and clipping control pane (right) 

5.1.2. Properties panel 

This panel shows the properties of the shape currently selected in the Shapes tree. It shows 

properties only if there is one — and only one — shape selected. Depending on the shape 

selected, the properties displayed change accordingly.  

The user can thus define the dimensions of the shape. For each shape, parameters vary and 

explanatory schemes are presented in section 5.2. These pictures are also available in the 

software by clicking on the “Help” button ( ). 

This panel shows also fields to choose the position and orientation of the object and the unit 

of measure. The unit for parameters, positions and rotations can be changed and an auto-

matic conversion of values is proposed. The default units are millimetres (mm) for lengths 

and radians (rad) for angles. 
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i. Thickness parameter and Boolean operations 

Some elements — such as boxes, ellipsoids, orbs, parallelepipeds and trapezoids — have an addi-

tional useful parameter (not present in GDML) called thickness. If a shape has a thickness defined 

(different from 0), then the export of this shape will be done using Boolean operations (a subtraction 

between the outer element and the inner element). It allows the user to gain time for this kind of opera-

tions.  

This kind of shape can be very useful during the definition 

of radiation analysis. The user shall be aware that this 

thickness value is not a GDML parameter, which means 

that setting this parameter to a value different from zero 

will result, in the GDML file, to the corresponding Boolean 

operation. The little warning sign ( ) next to the name of 

this parameter is present to remind the user of this. 

If an EDGE file containing a shape with a defined thick-

ness (different from 0) has been saved and is then loaded 

again, the user must note that the concerned shape will be 

displayed as Boolean operations. It means that when the 

user will click on the corresponding shape, it will be dis-

played as a Boolean operation and the user will not be 

able to edit it and change its dimensions, position and 

rotation parameters. 

5.1.3. 3D View 

The 3D view is showing in real-time the product of the GDML model. It is possible to interact 

with the view using the mouse to control it: 

 Left click (hold) and movement: rotate the scene; 

 Wheel (hold) and movement: translate the scene; 

 Right click (hold) and movement: zoom; 

Or the keyboard: 

 “R” resets the view and shows all the shapes of the scene; 

 “I” to zoom in; 

 “O” to zoom out;   

 “W” displays the shapes as wireframes; 

 “S” displays the shapes as solid; 

 The up/down/left/right arrows rotate the scene.  
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The buttons at the top of the view also facilitate its handling: 

  resets the view and shows all the shapes of the scene (“R” key shortcut); 

  aligns the view along +X axis; 

  aligns the view along -X axis; 

  aligns the view along +Y axis; 

  aligns the view along –Y axis; 

  aligns the view along +Z axis; 

  aligns the view along -Z axis. 

NB: Sometimes, at the launch of the software, the 3D view is not correctly initialised. To refresh it, 

change perspective to another one and come back to the initial perspective, the 3D view is now cor-

rectly initialised. It can also happen when using several screen and moving the application from one 

screen to another one. 

On top of the 3D view, a drop-down menu allows the user to choose a model operation to 

launch (cf. section 5.5). These operations are also available through the Tools menu pre-

sented in section 3.3.1.i. 

On the bottom of the 3D view, an information bar displays use-

ful information about the current selection: the number of se-

lected elements as well as the size and the position of the 

bounding box — the red box around selected elements. It is 

possible to click on the number of selected elements to display 

a list of the currently selected elements as shown on Figure 11. 

5.2. Available geometric shapes 

EDGE handles several primitive geometric shapes as shown on Figure 12. Other kind of 

shapes are also supported and presented in section 5.3. 

 

Figure 12: Available shapes 

 

The figures from Figure 13 to Figure 24 on the following pages present the parameters of all 

the shapes handled by EDGE. For concerned elements, the parameter thickness is ex-

plained.  

Figure 11: List of select-

ed elements 
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Figure 13: Box parameters 

 

Figure 14: Cone parameters 

 

 

Figure 15: Ellipsoid parameters 

 

Figure 16: Elliptical cone parameters 
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Figure 17: Elliptical tube parameters 

 

Figure 18: General trapezoid parameters 

 

 

 

Figure 19: Orb parameters 

 

Figure 20: Paraboloid parameters 
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Figure 21: Parallelepiped parameters 

 

Figure 22: Sphere parameters 

 

Figure 23: Trapezoid parameters 

 

Figure 24: Tube parameters 
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5.3. Other shapes available  

5.3.1. Tessellated Solid 

Solids with complex geometries can be constructed by importing tessellated surfaces, includ-

ing initially B-Rep based models. Numerous formats are supported (.geo, mesh file, STEP 

AP 203 – 214 ...). Those tessellated surfaces are converted into an equivalent GDML tessel-

lated solid object. 

Please notice that the imported tessellated surface must imperatively be a close surface. 

EDGE displays a warning message to the user if it is not the case.  

 

Figure 25: Example of an imported tessellated solid 

5.3.2. Assemblies 

In EDGE, the user has the possibility to handle “assembly” elements. Those elements are 

grouping several shapes without being attached to a geometric shape. 
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5.3.3. GDML file 

EDGE also allows importing all the geometry concepts from another GDML file and including 

them as a child of the currently selected element. This option can be very useful if users want 

to check the position of a specific subsystem (defined in the imported GDML file) in the whole 

system (main GDML file). An example is shown on Figure 26. 

 

Figure 26: Example of import of GDML file 

5.4. Edition of the geometry 

5.4.1. Creating/adding a new shape 

The user has first to create a “world” shape that will include all subsequent shapes. The posi-

tion (0, 0, 0) corresponds to the barycentre of this world shape. Once this is done, it is possi-

ble to start the construction of the desired object. 

NB: Even if technically GDML allows creating a world smaller than the final object, it is not recom-

mended. The world shape typically corresponds to the computational domain of numerous of simula-

tion software using GDML files in input. And most of these tools will not work properly nor give rele-

vant results if the world shape does not encapsulate all other elements. The relevant definition of the 

world shape remains on the responsibility of the user and with respect to the final targeted application.  
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Clicking on the “ ” button (or the Add the world shape /“ ” link if the corre-

sponding option in the Preferences is enabled, see section 4), calls the New Shape Wizard 

(Figure 27). On the left panel of the dialog box, all the available shapes are represented. A 

click on a shape selects it and shows its properties on the right panel. Properties requirement 

varies with the different shapes, but for each ones the Name, Unit Configuration, Position 

and Rotation can be informed. All the properties can be edited via the Properties Panel 

(Figure 8, box 2).  

 

Figure 27: New shape dialog box 

If the tree is empty, the first new shape will become the “world” shape. After that, each new 

shape will be added to the tree as a child of the current selected element. If no element is 

selected, the new element will be added as a child of the “world box”. This feature makes 

possible the creation of objects with a complex hierarchy of objects.  

The new shape dialog box displays all the available import options which may vary depend-

ing on the installed plug-ins. Basic ones are the B-Rep format files import (.geo, .msh, .stl, 

.unv), or the GDML file import. 
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5.4.2.  Transforming several elements 

Position and orientation can be directly edited in the properties panel. However, as it is not 

convenient to use this feature on each element to move, a multi-transformation tool has been 

implemented, accessible via the “Transform” icon of the Shapes tree panel (see section 

5.1.1). 

Once the elements to modify in the tree are selected, click on the Transform button   ( ). 

The dialog box showed in Figure 28 then appears. 

 

Figure 28: Multi-element transformation dialog 

This dialog box allows setting the translation and rotation to apply to the elements. 

These transformations can replace the current position and orientation properties of the ob-

jects or be added to any existing placement information. For example, for an object at a (1, 1, 

1) position, a transformation of (2, 0, 0) with “Add” will displace the object to (3, 1, 1), when 

“Replace” will displace it to (2, 0, 0). 
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5.5. Model operations 

The user can obtain information about the created shapes thanks to the drop-down menu 

“Model operations”. The list of available operations may be subject to changes. Available 

operations are: 

 GDML File validity check: checks the syntax validity of a GDML file against the GDML 

file format specifications. It is possible to check the current file (if saved beforehand) 

or any file from the system. The Figure 29 shows the tool appearance. 

 

Figure 29: GDML file validity check tool 

 Check for overlaps: allows the user to check if there are no overlaps inside the geom-

etry, meaning that there are no shapes overlapping each other. The user can choose 

if “touching” shapes should be considered as overlapping or not. To launch the calcu-

lation, the user can click on the “Play” button. The “Stop” button allows the user to 

stop the calculation at any time. The results of the operation are presented on Figure 

30. 

 

Figure 30: Overlaps calculation results  

(indicates that the Box2 and Box elements are overlapping) 
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 Compute volume: allows the user to obtain the volume of the geometry. The comput-

ed value is an approximation of the real volume value based on 3D meshing of the 

shapes. As for the previous operation, the calculation is launch with the “Play” button 

and can be stopped with the “Stop” button (cf. Figure 31). 

 

Figure 31: Volume computation results 

 Reorganise model: allows the user to check the consistency of the hierarchy of the 

model. Indeed, to get proper radiations results, elements that are included in other 

ones (geometrically) should be placed as child of the geometrical shapes they are in. 

This tool computes the real hierarchy, displays the results to the user and proposes to 

modify the model accordingly. NB: due to current limitation on this tool, it will remove 

all assemblies from the model. 

 

Figure 32: Exemple of hierarchy reorganisation results. 
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6. Material definition 

The aim of this perspective is to define materials that will be attributed later to a geometric 

shape. 

The Material definition perspective has no 3D view but is composed of three main panels, as 

shown on Figure 33: 

  Materials list, the list of user-defined materials; 

  Geant4 Materials, the list of available Geant4 default materials; 

  Material editor, panel to edit the currently selected material.  

  

Figure 33: EDGE material definition view 
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6.1. About GDML materials 

GDML materials are defined by describing the stoichiometry of elements. Materials can be 

defined by a single “atom”, a composition of elements or fractions of elements. These ele-

ments can be simple “atom” or represent an isotropic distribution. Figure 35 presents differ-

ent examples of material defined using the GDML formalism. 

 

Figure 34: Material definition in GDML 

 

Figure 35: Examples of different ways of defining a material in GDML 

6.2. Materials list 

Creating a material is performed by clicking on the “add material button” ( ).  

Warning: If the user creates a new material which is not attributed to a geometrical shape in the Mate-

rials affectation perspective, this material will not be saved inside the .gdml file when the user saves 

the file to GDML in EDGE. In order to save materials which are not attributed inside the .gdml file, 

the user needs to activate the corresponding option, see section 4.2. 

In order to edit a material, a click on an element in the list updates the material editor with the 

current material where it can be edited (see section 6.4). It is possible to duplicate a material 
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by clicking on the “duplicate button” ( ). Those new materials are added at the end of the 

materials list and their names are incremented in order to not confuse them with the initial 

materials. Deleting a selected material is performed by clicking on the “delete button” ( ). 

By clicking on the “import materials button” ( ), it is possible to import materials from an-

other GDML file or from a GDML materials XML file. In the case of a GDML file, this mecha-

nism will import all materials written inside the GDML file. We remind that in order to write all 

materials in a GDML file, even the ones which are not assigned to a geometry shape, the 

user must enable the corresponding option in the Preferences (see section 4.2). 

Finally, clicking on the “export materials button” ( ) exports the materials into a GDML 

material file (.xml). All the user-defined materials will be exported. 

6.3. Geant4 materials 

Available Geant4 materials for the material assignment (see section 7) are displayed in the 

Geant4 materials panel, as shown on Figure 33. 

6.4. Material editor 

The material editor is separated in two main parts: the first one on the top is the same for 

every material allows defining the name, the density and other properties of the material. 

Below, a section enables to define the composition of the material and changes depending 

on the type of chosen material. Figure 36 below shows the editor for a simple “atom” materi-

al. On the top, it is possible to fill in the material name, the density in g/cm3 and optional 

properties before choosing the type of material. 

  

Figure 36: Material editor for an "atom" material showing the optional properties 
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General optional properties can be set by clicking on the “Show optional properties” and are: 

 The choice of the atomic number Z; 

 The formula; 

 The state (liquid, solid, gaseous); 

 The absorption length (AL); 

 The mean excitation energy (MEE); 

 The pressure (P); 

 The radiation length (RL); 

 The temperature (T). 

The user can then choose a material type. As shows Figure 34, a material can be defined by 

three different ways.  

  

Figure 37: Material editor for a composition of element (here water) 

Figure 37 shows the material editor for a composition of elements. These elements are simi-

lar to atom shown previously but can have additional meta-data attached to them using the 

“Show optional properties” button. The number of each element is chosen on the left with the 

“n” field. It is easy to add and remove elements just by clicking on the ( ) button and ( ) 

respectively. 

It is possible to define material with isotopes instead of elements. In this case each element 

is made of fractions of isotopes. Also, it is possible to define a material with fractions of ele-

ments/isotopes instead of compositions. 

To apply the modifications, it is necessary to click on the “Apply modifications” button. 
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7. Materials assignment 

The aim of this perspective is to apply the materials defined in the material definition view to 

the geometry defined in the geometry edition view. Thus, this view only makes sense when 

at least one shape has been defined in the geometry perspective. 

The materials assignment perspective has the same 3D view as the geometry one (like 

shown on Figure 38):  

  Materials list, list of the geometric shapes and their currently applied material; 

  Material selection, panel to select the material for the currently selected shapes. 

 

Figure 38: EDGE material edition view 

 

7.1. Materials list 

This panel contains a table with two columns. The first column (on the left) lists the geometry 

shapes created in the Geometry edition perspective. The second column (on the right) lists 

the materials attributed to each corresponding geometry shape.  

By default, the Geant4 material “G4_Galactic” (i.e. space environment) is attributed to the geometry 

shape representing the world. All other geometry shapes created are, by default, composed of “De-

fault_Material”. This behaviour can be changed in the Preferences, see section 4.1. 
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7.2. Material selection 

The Material selection panel allows the user to select the material to attribute to a geometry 

shape, defined in the Geometry edition perspective. 

When a geometry shape is selected in the Material list panel, the Material selection panel 

displays several choices for the user: 

 Pre-defined materials: some pre-defined materials exist (see section 6.3) and can 

be directly used to define the material for the selected shape. When this option is se-

lected, a drop down list appears, displaying all default materials already available in 

EDGE (the embedded “Default_Material” and all Geant4 materials).  

 Custom materials: When this option is selected, a drop down list appears, displaying 

all the materials created in the Material definition perspective. 

When the chosen materials are selected in the drop down list, the modification must be 

saved by clicking on the “OK” button. 

 

 

 

 

 

 



 EDGE 2.3.2 

User Manual 
PAGE 

36/37 

 

Status: final Date: 15/10/2018  

 

8. Annex A: Example of materials description 

Here after is presented an example of material definition in GDML format (partial descrip-

tion).  

<materials> 

     <!--   Examples of basic or fundamental materials --> 

 <element name="videRef" formula="VACUUM" Z="1"> 

  <atom value="1"/> 

 </element> 

 

 <element name="aluminum" formula="Al" Z="13"> 

  <atom value="26.9815"/> 

 </element> 

 

 <element name="carbon" formula="C" Z="6"> 

  <atom value="12.0107"/> 

 </element> 

 

 <element name="Hydrogen" formula="H2" Z="1"> 

  <atom value="1.01"/> 

 </element> 

 

 <element name="Nitrogen" formula="N2" Z="7"> 

  <atom value="14.01"/> 

 </element> 

 

 <element name="Oxygen" formula="O2" Z="8"> 

  <atom value="16.0"/> 

 </element> 

 

     <!--   Examples of complex or composite materials --> 

 <material name="Mat_ALUMINUM" formula="ALUMINUM"> 

  <D value ="2.7000" unit="g/cm3"/> 

  <fraction n="1.0000" ref="aluminum"/> 

 </material> 

 

 <material name="Mat_Kapton" formula="Kapton"> 

  <D value ="1.42" unit="g/cm3"/> 

  <fraction n="0.0273" ref="Hydrogen"/> 

  <fraction n="0.7213" ref="carbon"/> 

  <fraction n="0.0765" ref="Nitrogen"/> 

  <fraction n="0.1749" ref="Oxygen"/> 

 </material> 

</materials> 
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